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File Menu

New ...
Open ...
Close
Save
Save As ...
Save All
Coverpage Gallery
Fax Header Gallery



New

Creates a new COMponent window as one of the following types:

FAXCOMponent Window
VIEWCOMponent Cover Page
VIEWCOMponent Fax Header
VIEWCOMponent Fax File

You may open as many of each type of window as you would like.    Keep in mind that each 
FAXCOMponent Window, however, must be connected to a unique line.



Open

Opens an existing COMponent document:

FAXCOMponent Window
VIEWCOMponent Cover Page
VIEWCOMponent Fax Header
VIEWCOMponent Fax File



Close

Closes the active document window.

Although several documents may be open at once, this command closes only the active document (you 
make a document active by clicking on its title bar.)



Save

Saves the active document to the directory and filename associated with it when the file was opened.

Although several documents may be open at once, this command closes only the active document (you 
make a document active by clicking on its title bar.)



Save As

Saves the active document to a different directory and/or filename than it was associated with when it was
opened.

Although several documents may be open at once, this command closes only the active document (you 
make a document active by clicking on its title bar.)



Save All

Saves all open documents at once.



Fax Coverpage Gallery

The Coverpage Gallery is a place where you may store your most often used cover pages for easy 
access.

Any Coverpages that you choose to add to the Coverpage Gallery will be accessable from the Coverpage
Gallery dialog.    The preview and description sections of the Coverpage Gallery dialog make it easier for 
you to identify the Coverpage you would like to select.

Cover pages must be added to the Cover Page Gallery in order for them to be accessible when sending a
fax.



Fax Header Gallery

The Fax Header Gallery is a collection of your favorite fax headers.

You can add fax headers you have created to the gallery and it will provide a list of them that allows you 
to easily access any fax header you need.



Coverpage Gallery / Fax Header Gallery

NOTE: The Cover Page Gallery and Fax Header Gallery use the same dialog box style, so this help 
document covers both of them.

A gallery is a collection of documents you use frequently presented as a list for easy access.

To use the gallery:

Select the document you want to use from the list and click [OK] to get it.

· If you want to see what the selected document looks like before you get it, click the [Preview 
>>] button.

· Add new documents to the list by clicking on [Add...]

· Clear a document from the list by selecting it and clicking on [Delete].



View Menu

Normal View
Queue View
Job View
Status View



Normal View

Selecting this option positions the splitter bars in the FAXCOMponent window at default positions 
enabling you to see the Schedule Queue, Job Detail, and Job Status panes all at the same time.

Note:    You can change the size of the panes by clicking the LEFT mouse button on a splitter bar and 
dragging it to the desired position.



Queue View

Selecting this option positions the splitters so that the entire FAXCOMponent Window is occupied by the 
Schedule Queue pane.

Note:    You can change the size of the panes by clicking the LEFT mouse button on a splitter bar and 
dragging it to the desired position.



Job View

Selecting this option positions the splitters so that the entire FAXCOMponent Window is occupied by the 
Job View pane.

Note:    You can change the size of the panes by clicking the LEFT mouse button on a splitter bar and 
dragging it to the desired position.



Status View

Selecting this option positions the splitters so that the entire FAXCOMponent Window is occupied by the 
Fax Status View pane only.

Note:    You can change the size of the panes by clicking the LEFT mouse button on a splitter bar and 
dragging it to the desired position.



Help Menu

Index
Using Help

About FAXCOMponent



About FAXCOMponent

Display system, version and distribution information about the FAXCOMponent.



Fax Menu

Send Fax...
Modify Fax Job ...
Delete Fax Job
Abort Fax
Load Queue Server
Enable Receiving
Manual Receive
Create / Edit Phonebooks ...
Access Phonebooks ...
Access Logs ...
Settings ...



Send Fax

This command invokes the Fax Wizard which guides you through the process of creating and scheduling 
a fax for transmission.

The Fax Wizard consists of several pages that allow you to enter step-by-step information which will lead 
to the creation of a fax document for transmission to someone.    You can preview the fax before it is 
transmitted by selecting the [Preview...] button.    You can also schedule the fax to be sent at a later time. 
Help for each page can be selected below:

Page 1: Send Fax Type - which type of fax to send?
Page 2: Destinations - where is fax going?
Page 3: Files - which files do you want to include in the transmission?
Page 4: Cover/Header - what coversheet and header page to send (if any)?
Page 5: Schedule - when do you want to send the fax?

Note:    Depending upon the setup option in Fax Settings, selecting Send Fax will either display the Fax 
Wizard which will guide you through all steps required to send a fax, or it will display a normal tabbed 
dialog which some users may find more efficient once they are famaliar with the process of sending a fax.

When sending faxes from the printer driver the Model Fax Settings will be used to determine whether to 
display the Fax Wizard or the tabbed dialog.

Note that there is a [Preview...] button which will allow you to print and/or view the fax as it will be sent 
prior to sending.



Modify Fax Job

This command modifies information in the currently selected fax job.

All fax jobs which have been created are listed in the Fax Window with information on whether they are 
active, the scheduled start time, etc.    Any information you specified for a fax job when it was created can 
be modified while the job is pending before it becomes active.    Once a job has become active and is 
currently being processed, you will not be allowed to modify the job.

To change the information about a fax job, do the following:

1. Make sure the fax window is active and select a fax job by clicking anywhere on its line.

2. From the Fax Menu, click on Modify Fax Job or from the job information window in the lower 
left pane of the fax window click the Modify button.    A tabbed dialog will be displayed.    The 
number and type of tabs that are available depends upon the type of job that was originally 
selected when the job was created.

You can change attributes of the fax job by clicking on the appropriate tab:

Send Type - the type of fax job.
Destinations - where to send the fax.
Attachments - which fax file(s) to send.
Memo - the text that appears on a memo fax..
Cover/Header - the cover sheet and header to send.
Date/Time - the date and time that the fax is scheduled to be sent.



Delete Fax Job

Selecting this entry allows you to delete the selected fax job.    You may not delete jobs that are active.    
Any job that is deleted will be permanently removed from the schedule queue.



Load Queue Server

Selecting this causes the Queue Server application to be loaded.    The Queue Server allows the 
FAXCOMponent to continue sending and receiving faxes even when the FAXCOMponent or COMponent 
Workspace applications are not running.



Enable Receiving

When checked, enables the ability of the FAXCOMponent to receive faxes.    Use this option to 
temporarily disable the automatic fax receive capability.



Manual Receive

Select this option to force the FAXCOMponent to answer the line and attempt to connect and receive a 
fax.



Create/Edit PhoneBooks

This dialog is used to create and maintain phone lists; it consists of three sections:

Phone Lists Window - shows existing phone lists you previously created and allows you to 
delete and reorder them and create new ones.

Fields Tab - for changing the structure of a phonelist database.

Options Tab - for changing the way a phonelist is displayed.



Access Phonebooks

This dialog is for maintenance of records within the phone lists you have created.    Use this dialog to add 
or edit new records and groups.



Settings

This tabbed dialog allows you to modify settings related to fax operations.

There are four tabs in this dialog:

Send - Modifies options used when sending faxes.

Receive - Modifies options used when receiving faxes.

Hardware - Modifies the line that the active fax window is connected to.

General - Modifies miscellaneous options related to faxing.



FAXCOMponent Settings - Send Tab

This tab allows you set some basic settings related to fax send operations.

These settings are applied to the FAXCOMponent Window selected in the Settings For: list box.    To 
change settings for a specific window, click on the session name in the listbox.    You may also modify 
multiple windows’ settings simultaneously by selecting multiple items in the list.    The Model Fax entry 
always appears at the bottom of the list and represents default settings that will be used when creating 
“New” FAXCOMponent Windows by selecting New... from the File menu.

The areas on this tab are:

· Fax Document Storage

- Specify which outbox to use for storage of outgoing fax documents.

· Send Queue Options

- Specify how often the fax schedule queue is checked to determine if any faxes are 
ready to be sent.

· Default Fax Resolution

- Specify the default resolution to be used for conversion of fax files to be sent.

· Send Interface Options

- Specify the whether you wish to use the Fax Wizard to schedule a fax for sending or a 
regular tabbed dialog.    Once you are familiar with the process of sending a fax you 
may find it more efficient to use the Tabbed Dialog interface option.



FAXCOMponent Settings - Receive Tab

This tab allows you set some basic settings related to fax receive operations.

These settings are applied to the FAXCOMponent Window selected in the Settings For: list box.    To 
change settings for a specific window, click on the session name in the listbox.    You may also modify 
multiple windows’ settings simultaneously by selecting multiple items in the list.    The Model Fax entry 
always appears at the bottom of the list and represents default settings that will be used when creating 
“New” FAXCOMponent Windows by selecting New... from the File menu.

The areas on this tab are:

· InBox

- This entry allows you to specify which inbox to use for storage incoming    fax 
documents.

· Receive Fax Action

-There are several things you can when a fax is received:

Enable Fax Receiving - Must be checked for the FAXCOMponent to 
automatically answer incoming fax calls.

Print Fax on Receive to - Automatically print received faxes to the specified 
printer.

View Fax on Receive - Automatically launch a VIEWCOMponent window 
containing the received fax document.

Notify on Receive:

Display Message Box - Displays a message box informing you that a new fax 
file was just received.

Beep Speaker - Beeps the system speaker when a fax is received.

Play Sound File - Plays the selected sound file when a fax is received.



FAXCOMponent Settings - Hardware Tab

Change modem line settings.

This tab allows you to edit the settings for the line that you are currently connected to and to change to 
another line.

To add or remove lines use Line Setup from the Options menu.

See Also:    Configure Line/Modem



FAXCOMponent Settings- General Tab

General settings you can specify for the active fax window.

· Automatically Save Fax Settings

- Turning this option on supresses the dialog prompting you to save fax settings when 
exiting the program.



Fax Wizard - Send Fax Type

This page of the Fax Wizard is for selection of the type of fax you want to send.

There are three types of fax documents to choose from:

Standard
Sends one or more fax files.    You may select pre-converted, previously received
or newly created fax files to send.

Cover Only
ends a fax consisting of only a coversheet.

Text Memo
ends a short text memo without a coversheet.

Select the fax type by clicking the radio button to the left of the type name.



Fax Wizard - Destinations

This Fax Wizard page is for choosing the send destination of the fax job you are creating.

The faxing process can be setup to send a single fax or several faxes at once.    Also the destination to 
send the fax(es) can be one or more people.

To establish a destination to send the fax(es), use the following steps:

1.Select a phone list by clicking on its tab in the card-file-like area at the to the page.

2.Select the name of the person you want to fax to by clicking on it.

3.Click the Add Item button to the right of the Destinations window at the bottom of the page.    
The name will appear as an item in the Destinations window.

Hint:    You may also drag the entries and drop them on the Destinations window.

4.Repeat steps 1-3 for each person who will receive your fax.

The Destinations window will contain a list of people you have selected to receive your fax.
When a name is selected in this window, the fax number and name will appear in edit boxes at the bottom
right of the page.    These boxes allow you to change the name and/or number
on-the-fly.

Other buttons on this page:

· To remove a name from the list, click on the name in the Destinations window and when it is 
selected, click on the Remove Item button to the right.

· The Add New Record button allows you to create a new record in the selected phone list.    
This new record becomes part of the selected phone list database.

· The Edit Record button is for editing of the currently selected record in the selected phone 
list.    The changes made to this record are recorded in the selected phone list database.

· The Temporary Record button allows you to create a simple record with basic name and 
phone number information for use only in the fax job you are currently creating.    The record 
does not become part of any phone list database, but it does become a member of the list of 
people to receive the fax and is displayed in the Destinations window.    The temporary record
can be removed from the list as described above.



Fax Wizard - Files

This Fax Wizard page is for selection of the fax files which will be transmitted in the fax job you are 
creating.    Note that if you are printing from the printer driver, the file you are printing will be the first file 
that is sent.    All additional files that you pick in this dialog must be preconverted fax(.CPF) or ASCII Text 
files.    If you are not printing from the printer driver, the files you select are sent in the order you select 
them.

Here are the steps for selecting fax files:

1. Choose a fax file by using the File Name, Directories, and Drives boxes to find and select it.    
The file contents are shown in the Preview window to the right of the Directories box. 

2. Click on the [Add File] button on the bottom right of the page.    The filename and its path are 
displayed in the window at the bottom of the page.

3. Repeat steps 1 and 2 for each file to be included in this fax job.    The files appear as a list in 
the window at the bottom of the page.

You can remove a file from the list by selecting it in the window and clicking the [Remove file] button or 
remove all the files at once by selecting the [Remove All] button, both located at the bottom right of the 
page.

The Include Annotations check box allows you to specify whether or not any annotations which you may 
have on a fax page will be sent or not.    This check box applies to all files that you have selected for the 
send.

You may choose to suppress page breaks which will cause the fax to be sent as one long page.



Fax Wizard - Cover/Header

This Fax Wizard page allows you to choose the coverpage and/or header to use in the fax job you are 
creating.

· Cover Sheet section:

- Click the Yes button to include a coverpage or the No button to exclude it.

- If you are including a cover page, select the one you want from the Available Cover 
Sheets list.    The cover page will be presented in the Preview section of the page.

- If your cover page contains any User-Defined fields, the Modify Fields button will be 
enabled.    You can go into the modify fields dialog to change or enter any custom text 
that you would like to place on the cover sheet.    Often people use this capablility by 
including a small user-defined Memo field on the cover sheet.    They can the type in the
memo by selecting the Modify Fields... button.

· Headers section:

- Click the appropriate button depending whether you want no header or you want it to 
show    on just the first page of the fax transmission or all pages.

- If you are including a fax header, select the one you want from the Available Fax 
Headers list.    The fax header    will be presented in the Preview section of the page.

· Preview section:

- Shows what the cover page and fax header look like before faxing.

- Use the scroll bars to move around the preview and the + and - buttons underneath the 
preview to enlarge and reduce it.    The page icon underneath the preview identifies the 
page number of the coversheet or header.



Fax Wizard - Schedule

This Fax Wizard page allows you to define the time when fax jobs are to be transmitted.

A job can be sent immediately or scheduled to be sent at a specific time - use the calendar and time 
controls to specify the time to send.

Clicking on As Soon As Possible sets the date and time to the current date and time.

You can specify the exact line that you want the fax to be sent out on by picking it from the Outbound Line
combo box.    If you do not care which line it is sent on select “Any available line”.



Fax Wizard - Memo

Create a fax memo.

Enter the text that you would like to appear on this memo fax.



Fax Wizard - Send Fax Type

This page of the Fax Wizard is for setting parameters specific for this job

Service

The name of the Service location and phone number

Dialable number

The phone number to be dialed to connect to the service

Off Peak

 Schedule faxes for Off Peak delivery. Today this is set    between 21.00 to 9.00

Delivery 

As soon as possible, Off Peak or Deferred in 24 hour format NOT AM,PM Delivers the fax at the 
indicated time (24 hour format). It is only possible to schedule a fax delivery at maximum + 24 
hours.

Cancellation

Standard or Time. The server will cancel message delivery if it has not been delivered before the 
time given. Time in 24 hour format.

Name and Company. 

The sender of the fax. This information will be placed on the Cover page and in the fax header on 
each page. The information in this field will be taken from the Location Setup menu

Billing Code

Includes a code for billing information for use at the server side. 

Reference

Reference information placed on the coverpage of the fax and as an internal reference. 



Dial Options

You can override the default dialing options for any records by changing the options in this dialog.    The 
number that will be dialed is displayed at the top of the dialog.

There are three different categories of options that may be modified:

International Options -- Checking this option causes the international access number (011 for the United
States) to be dialed if the number is an international call.    This option is checked on by default.

Long Distance Options -- Checking this option causes the long distance access number (normally 1 for 
the United States) to be dialed if the number is a long distance call.    This option is checked on 
by default.

Local Options
Dial as Long Distance (Local Toll) -- Checking this option causes a local number to be dialed as 

though it were a long distance number. The Long Distance Options are observed when dialing 
as a local toll.    This option is checked off by default.

Omit First Digit of Phone Number -- Checking this option causes the first digit of the phone number 
to not be dialed.    In some countries when dialing a local call, the first digit is not required.    This 
option is checked off by default.



Advanced Fax Options

Use this dialog to override the default timeouts and retry counts for a record.    You can also specify an 
overide for your fax-modem station ID.

The Fax Station ID is specified in the Configuration dialog for the each line and can be accessed from 
Line/Modem Setup from the Options menu.    With the Advanced Options dialog you can override the 
default station ID associated with a line on a record by record basis.    This allows you to make sure that 
the remote fax system can see a specific Station ID for you modem without having to change it globally 
from within the line configuration dialog.

The Expected Remote CSID is the Station ID that you expect to see when dialing the current fax 
destination.    You can choose to terminate the connection if the fax machine you connect to doesn’t have 
a matching CSID.



Temporary Destination

Enter the phone number, name, company and country of the locaton to which you wiish to send the fax.    
This creates a temporary phone record that is not added to the phonelist and which exists only for the 
duration of the current send job.



Font Selection

This is a standard windows font selection dialog.



Dockable Phone Bar

This is a hideable tabbed window that can be placed anywhere in the FAXCOMponent window.

The dockable phone bar presents a card-file-like view of the phone lists you have created and allows you 
to modify phone list properties and individual records within the phone list database.

The phone bar’s layout consists of:

· Tabs representing your phone lists.

· A window area below the tabs, which displays a list of records in the currently selected phone 
list.

· A button bar on the left, which allow you to access the tools necessary to maintain the selected
phone list.    These tools include:

Add Phone List Entry
Edit Phone List Entry
Delete Phone List Entry
Find Phone List Entry
Access phone list Notes
Access phone list Properties

NOTE:    clicking the Right Mouse button while the mouse cursor is inside the phone list’s window
will bring up a menu of these tools.

The dockable phone bar serves as a quick way to access your phone lists and the information contained 
within them.

See Also:

Create/Edit Phonebooks
Access Phonebooks



Abort Fax

When a fax job is in progress, either sending or receiving, selecting this will cause the current operation to
be terminated immediately.    A log entry will still be made, even for aborted fax operations with the error 
code of “User Cancelled”.



Access Logs

Use the logs to view information about previously sent or received FAX documents.    This is a convient 
dialog to access when you want to view, print, or re-send any sent or received fax file documents.    You 
can also view detailed information about each particular fax job, including the type of error that occurred if
any.

See Also:    MailBox/Log Access



Fax OutBox Details

Use this dialog to view the details of a send fax job.

The top portion of the dialog contains job specific details.    You can use the combo box to display the 
specific results for each destination in the send job if more that one destination was specified.    By 
clicking the [Error Help...] button you will be taken to a precise explanation of the error and some 
potential solutions.

A preview window is provided as well, to allow you to see which files belonged to the send.    Use the 
Documents combo box below the preview window to look at each individual document.



Fax InBox Details

Use this dialog to view the details of a received fax job.

The top portion of the dialog contains job specific details.    By clicking the [Error Help...] button you will 
be taken to a precise explanation of the error and some potential solutions.

A preview window is provided as well, to allow you to see the received file (if any).



How To Send A FAX

Sending a fax is actually a very simple process.    There are only two things you need to know send a fax: 
1.    What fax file do I want to send? and 2.    Where do I want to send it?

There are two methods for beginning a fax send operation.    You can either print to the FAXCOMponent 
Printer Driver from any Windows application that can print, or you can send pre-converted or previously 
received fax files by selecting Send Fax... from the Fax menu within the FAXCOMponent.    You will not be
able to send by selecting Send Fax from the Fax menu until you have opened a FAXCOMponent Window 
from either the COMponent Workspace or the FAXCOMponent.    If you are using the print driver and no 
FAXCOMponent Windows are currently up and running, the Queue Server application will be run 
automatically to send your fax.

Whichever method you choose, you will be presented with a Fax Wizard.    This wizard will guide you 
through all of the steps required to schedule and send a fax.l

The Destinations page of the Fax Wizard allows you select where you would like the fax to go.    You may 
either select existing records from the phone list or create a temporary record.    Once you have selected 
the destination, you may choose to send a cover page or not, and finally use the Date/Time page to select
when the fax will be transmitted.    At each stage of the Fax Wizard you may click on the Help button the 
receive help on the details of that page.



How To Receive A FAX
To receive a fax make sure you have a FAXCOMponent Window open and it has properly initialized your 
modem.    Make sure that receiving is enabled.    You may check this by looking at the Enable Receiving 
option in the Fax menu.    You may also choose to enable some special options by going into Settings... 
from the Fax menu.    You can setup the FAXCOMponent to display a message box, play a WAV file, or 
automatically view the fax when it is received.    Once everything has been properly configured, files 
should be automatically received.    You can view the Status portion of the FAXCOMponent Window to see
the progress of the incoming fax.

Once the fax has been received, an entry will be placed in the Inbox.    You may view the Inbox by 
selecting Access Logs from the Fax menu.



FAXCOMponent Troubleshooting
Problem:

Faxes can be scheduled and start to send, but errors occur before the modem dials.

Solution:
Make sure you modem is turned on and properly configured.    Make sure the fax Class that your 
modem supports is selected though the Fax Tab in Line/Modem Setup... Configure Line... from 
the Options menu.

If everything checks out from within COMponents, try your modem out with one the built-in 
Windows Datacomm packages such as Terminal or Hyper-Terminal.    If these packages cannot 
communicate with your modem, you most likely have a hardware configuration problem.    Re-
read you modem’s installation manual and ensure that the modem is properly configured.    If 
necessary use Line/Modem setup from the Options... menu in COMponents to automatically re-
detect and configure your modem for use in COMponents.

Problem:
For incoming calls, the phone rings and rings, but does not answer.

Solution:
Make sure that fax receiving is enabled from the FAX menu.    You may also select the Manual 
Fax Receive option from the FAX menu when rings come in to have the FAXCOMponent answer 
the phone immediately.

Problem:
Fax calls are not being displayed in the MailBox/Log window.

Solution:
Make sure that you have the appropriate MailBox and folder selected in the left hand pane of the 
window.    Also, ensure that the “Show Only InBox Un-read” check box is not checked.    If using 
the log from the dockable phone bar, RIGHT click the mouse and make sure that no check box 
appears next to the Show InBox Unread Only menu item.

Problem:
How do I delete all the entries from the MailBox/Log at onece?

Solution:
RIGHT click the mouse to display the popup menu and selecte “Clear Log”.

Problem:
How do I delete all the entries from the MailBox/Log at onece?

Solution:
RIGHT click the mouse to display the popup menu and selecte “Clear Log”.

Problem:
I used to have the phone bar docked to my window, now the software says it is there but I cannot 
see it anymore.

Solution:



The phone bar is a sizable, dockable bar.    Check to make sure that it is not floating on your 
screen somewhere.    It may be floating but really small.    Also, if you believe it is docked to your 
main window frame, look for the splitter bar.    Position your mouse cursor over the splitter bar.    
When you are over the bar the cursor will change shape to a splitter cursor.    Click the LEFT 
mouse button and resize the bar until you can see it again.

Problem:
The FAXCOMponent is not creating the proper dialable number when is try to send a fax.

Solution:
Check to make sure you have the proper location setup from the Options... menu.    You must 
have at least the International Access Number, Country Code, Long Distance Access Number, 
and City/Area Code filled in so that the FAXCOMponent can determine how to dial the requested 
location.    Also make sure the the proper location is set as the default.

You may have inadvertently selected some options from within the Fax Tab of the phone list 
record.    Edit the phone list record and access the Dial Options... dialog from the FAX Tab.    
Check to make sure all of the options are accurate.



Window Menu

Cascade
Tile Horizontally
Tile Vertically
Arrange Icons



General

This tab defines basic information for the selected tool.    You may add and remove tools, as well as 
change the order in which the tools appear in the Tools menu.

The following areas are in this tab:

Main Info:
Description - Enter a description of the tool.
Command - The command that executes the tool program.
Arguments - Command line arguments used with the tool program.
Initial Directory - The directory containing the tool program.

Options:

Use in Menu - Select to show the tool name in the Tools menu. 
Prompt for Arguments - Ask for tool command arguments. 
Run minimized - Minimize the tool program when it is run. 

Browse - Select tool program path and name. 

Test - Run the tool program to make sure it works. 



Window

Use this tab to specify the intial size and position of the main window of the application or tool you are 
settings up.

Force On Feedback -- Forces the hourglass cursor to show until the application is first run.

Force Off Feedback -- The hourglass cursor will not show when the application is first run.

Note:    Some Windows programs will not observe the size and position values.



Console

The tab allows you to select size and color attributes if the application you are setting up is a console 
application.    You may set the number of rows and columns and the text and background colors.

Note:    Only console applications will make use of this information.    Console applications are text-mode 
programs designed for Windows NT only.



Options
Use this tab to specifiy advanced options for the application that you are launching.

Note:    Some of these options will only have an effect if you are running under Windows 95 or Window 
NT.

Console:
Applies to console applications only.    Select the options you would like

Process:
Specify the whether or not to run the new process in as a detached process and also 
whether or not you want to run it a private address space.

Priority:
Specify the priority of the main process thread for the application being launched.    
Unless you have a specific reason, you should always leave this setting at Normal.    
Otherwise the overall system performance (including faxing) may be adversely affected.



Add Tools Menu Item

Choose the path and filename of the new tool you want to add to the Tools menu.



FAXCOMponent Basics
The FAXCOMponent can be accessed by running it as a stand-alone program (V3FAXMCP.EXE) or from 
within the COMponent Workspace.    If run from within the COMponent Workspace the user mode (Novice
vs. Advanced) effects the types of documents or windows that the FAXCOMponent will allow you to 
create.

There are a few major differences when the FAXCOMponent is run in Novice vs. Advanced mode.    In 
Novice mode you are not allowed to create new cover pages or fax headers.    You are also only allowed 
to have one FAXCOMponent Window up at any one time.    This means only one modem will be able to 
send and receive faxes.    In Advanced mode all features are available.

A FAXCOMponent Window file (.FXW) is the document that provides access to your modem and its 
settings.    There is a one to one relationship between FAXCOMponent Windows and installed modems.    
In order to send and receive fax files you must create or open a FAXCOMponent Window for each 
modem you have installed.    You can create a new FAXCOMponent Window by selecting “New..” from the
“File” menu.    If you have more than one modem installed, you will be prompted to select which modem 
you want to associate with the window.    Once the modem has been associated with the window, you are 
ready to send and receive faxes.

To learn more about some of the common procedures see the following sections:
How To Send A FAX, How To Receive A FAX



FAXCOMponent Environment

The FAXCOMponent application is another module in the suite of COMponent modules.

It can be run as a stand-alone application, but it also is automatically integrated into the COMponent 
Workspace.    All of the functionality provided by the FAXCOMponent is available no matter how it is run or
where it is accessed from.    Furthermore, all of the functionality of the VIEWCOMponent is seamlessly 
integrated into the FAXCOMponent.    This means that you do not have to run the VIEWCOMponent 
separately in order to view, create or modify fax related files.

The FAXCOMponent, like other COMponent modules allows you to create any number of windows within 
its workspace.    This capability is called the “Multiple Document Interface” and is a standard user-
interface model which is used in many other Windows applications and should be famailiar to the 
Windows user with only a small amount of experience.

The “Multiple Document Interface” (MDI) is a powerful user interface model that allows you to open more 
than one document, in this case, fax file, cover page or header, simultaneously.    This makes it easy to 
switch between different files quickly and allows for quick transfer of data from one document to another.

There are four different types of documents that the FAXCOMponent can create or edit:

FAXCOMponent Window (.FXW)
A FAXCOMponent window can be created for each modem you have installed in your 
system.    All of the fax related settings for each modem are stored in the FXW file.    This 
capability allows you to store different settings in different FXW files and open them at a later 
time without having to recreate special settings.    The FAXCOMponent window consists of 
three views:

Schedule View
Displays the scheduled fax jobs in a queue list.

Job View
Allows you to easily see details on a scheduled fax job. 

Status View
Displays the status of currently active fax jobs. 

Cover Page (.CPC)
Any number of Cover Page documents can be created for use by the FAXCOMponent.

Header (.CPH)
Header documents are very similar to Cover Page documents, however they are used for a 
different purpose by the FAXCOMponent.    A header is the (usually) small strip of text across 
the top of a fax page.    The FAXCOMponent allows you to create the format of these headers
using all the same tools available to you when as you are creating a Cover Sheet; Including 
bitmaps. 

Fax (.CPF)
These can be documents received by the FAXCOMponent or documents that you have 
created by selecting New... and choosing Fax File from the list of available document types.

The FAXCOMponent is automatically configured to “remember” the position and information contained in 
the documents you have open when you close it down.    Moreover, when you restart the application, the 
previously opened documents will be automatically re-opened for you and any FAXCOMponent Windows 
you had open will attempt to open a connection to your modem.    You can turn this capability off in the 
Workspace dialog from the Options menu.



As with the other COMponent modules, the FAXCOMponent contains a Tools menu and an Options menu
that are always available.    The Tools menu, among other things, provides access to showing and hiding 
toolbars.    The Options menu can be used to alter settings related to the FAXCOMponent itself, such as 
the Workspace settings described above.



Options Menu
Location ...
Workspace ...
Language ...
Line/Modem Setup...
o.tel.o Multi-Fax...



Location
This dialog allows you to change settings specific to your current physical location.    These 

settings are used when sending faxes or calling other modems to build the proper dialiable phone number
and for text substitution on the cover pages and headers.

See Also:    Location Setup Dialog



Workspace
You may customize the look and feel of the applications windows from this dialog.    In addition to 

changing the background color and displaying bitmaps on the background you may also choose the user-
mode, Novice or Advanced.

See Also:    Workspace Tab



Language
Use this dialog to switch the language the user-interface is currently using.    If you have more 

than one language intstalled, you will be presented with all available languages in a list.    When you 
change the language, the user-interface will instantly change to the new language.    No rebooting or 
restarting the software is necessary.

See Also:    Language



Line/Modem Setup
If you wish to add, remove, or modify lines/modems from COMponents this is the correct option to

select.    This dialog allows you to auto-detect and Add newly installed modems as well as edit the 
configuration of exsitsing modems.

See Also:    Line/Modem Setup Dialog



o.tel.o Multi-Fax
o.tel.o Multi-Fax is the service for sending high volume faxes from this client through o.tel.o 
Muli-Fax service. You can design your faxes in your favorite Windows application, and print it 
through the fax component printer driver. You can as well attach TIFF, and ASCII files.

See Also:    o.tel.o Multi-Fax Service Setup



Phone List
A phonelist is a database which contains all the phone numbers you call.    You can create an unlimited 
number of different phone lists, each with a different catagory of phone numbers.    For example, you can 
have the following phone lists:

Personal  - containing only personal phone numbers
Business  - containing only business phone numbers

and so on ...

Each phone list shows up as a seperate tab in the dockable phone list window.



TIP:
Using "View of Selected Phone List", you can section a single phone list into several tabs in the phone list
window, each tab containing a list of phone numbers for one letter of the alphabet.    You will have tabs 
lettered A to Z across the phone list window and can simply click a letter to open a list of names that start 
only with the letter you chose.

You are not limited to the example above.    By using the filtering capabilities, you can break up a phone 
list into smaller parts that are sorted and filtered any way you want.



Local Phone List Database

Creates a new phonelist database which can be accessed only by your local computer.

To create the local phonelist:

1. In the New Phone List box, click the Local Phone List Database button then click [OK].

2. Enter a name for the phonelist in the Phone List Description dialog box.
(This defines a new phonelist which will appear in the Phone Lists window.)

3. You can define several lists at once by repeating steps 1 and 2 for each new list.

4. Once you have defined the list(s) you want, click [OK] to create them.
If you click [CANCEL], the defined list(s) will not be created.



Shared Phone List Database

Creates a new phonelist database which can be shared by network users.

To create the shared phonelist:

1. In the New Phone List box, click the Shared Phone List Database button then click [OK].

2. In the Select Directory box, enter the path of a directory for the shared phonelist.
(This must be a globally accessed directory available to other users on the network.)

3. Enter a name for the phone list in the Phone List Description dialog box.
(This will define a new phonelist which will appear in the Phone Lists window.)

4. You can define several lists at once by repeating steps 1, 2 and 3 for each new list.

5. Once you have defined the list(s) you want, click [OK] to create them.
If you click [CANCEL], the defined list(s) will not be created.



View of Shared Phone List

Creates a view into an existing shared phonelist database

No new database is created.    An existing shared phonelist database is attatched to a new tab in the 
phone list window.    The view can be sorted and filtered.

To create the shared phonelist view:

1. In the New Phone List box, click the View of Shared Phone List button then click [OK].

2. In the Select Directory box, enter the directory path which contains the shared phonelist 
database you want to create a view for.

3. In the Shared Phone Lists box, select the phonelist you want to create a view for and click the 
[OK] button.

4. Enter a name for the phone list in the Phone List Description dialog box.
(This will define a new phonelist view which will appear in the Phone Lists window.)

 
5. You can define several views at once by repeating steps 1, 2, 3 and 4 for each new view.

6. Once you have defined the view(s) you want, click [OK] to create them.
If you click [CANCEL], the defined view(s) will not be created.



View of Selected Phone List

Creates a view into an existing phonelist database

No new database is created.    An existing phonelist database is attatched to a new tab in the phonelist 
window.    The view can be sorted and filtered.

To create the phonelist view:

1. Click the phonelist you want to create a view for in the Phone Lists window.
(This will select the phonelist.)

2. Enter a name for the phonelist in the Phone List Description dialog box.
(This will define a new phonelist view which will appear in the Phone Lists window.)

 
3. You can define several views at once by repeating steps 1 and 2 for each new view.

4. Once you have defined the view(s) you want, click OK to create them.
If you click CANCEL, the defined view(s) will not be created.



Phone Lists Window

This section of the Phone List Properties dialog is used to create and delete phonelist databases and it 
lists all of the phone lists you have created.

The Phone List listbox contains all currently existing phone lists.

Creating a new phone list

To create a new phonelist:

1. Select the [New] button underneath the Phone Lists window.

2. The New Phone List dialog box appears and allows you to choose the type of phonelist to 
create.    Select one of the four types of phone lists:

Local Phone List Database
Shared Phone List Database
View of Shared Phone List
View of Selected Phone List

· When a new phonelist is defined, its description appears in the Phone List window.    If you 
select a phonelist description in the window, it will become the active phonelist.    Any changes
you make in the Fields and/or Options sections will affect the selected phonelist.

· You can change the structure of the phonelist database and whether you want it to show up as
a tab in the dockable phone lists area using the Phone List Properties Fields and Options 
tabs.

After you complete the above procedure, the phone list database(s) you set up are only defined. To finish 
creating the phone list(s), click the [OK] button located on the Phone List Properties Dialog.

If you change your mind and do not want to create the phone list(s) you have defined, click the [CANCEL]
button on Phone List Properties dialog.

USEFUL TIP

Deleting a phone list

To delete a phonelist:

1. Highlight the name of the phonelist in the Phone Lists window.

2. Click on the [Delete] button underneath the Phone Lists window.

The name of the deleted phone list will disappear from the Phone Lists window.

Changing the order of phone list databases

When you create a phonelist, you can specify whether it will appear as a tab in the Dockable Phone Bar 
or not.



The order in which the phonelist tabs appear on the bar depends on the order they are placed in the 
Phone Lists window on the Phone List Properties dialog.    You can change the ordering of phone lists as 
they appear on the bar.

To change the phonelist order:

1. Click on the name of a phonelist to move in the Phone Lists window.

2. Click on the [Move Up] and [Move Down] buttons just below the Phone Lists window to adjust
the position of the selected phonelist in the ordering scheme.

· The left-to-right order of phonelist tabs on the dockable phone bar corresponds with the top-to-
bottom order of the Phone List window, so the first phonelist will be the leftmost tab.



Phone List Properties - Fields Tab

The information on this tab is used to modify the structure of a phone list database.

NOTE:    Before making any changes, make sure the phonelist you want to change is selected in the 
Phone Lists window.

Fields section

This section maintains the record structure inside the phone list database; it consists of the following 
areas:

· Fields window
- Contains a list of fields which are used to store information for each record in the phone 

list.

· Field modification buttons
- These buttons, to the right of the fields window, make changes to the structure of the 

record fields:

· Move Up and Move Down buttons
- Move the field selected in the fields window up in the list of fields.

(The order in which the fields appear in the fields window is the order in which they are 
displayed in the column header of the phonelist tab.)

· Add ...
- Allows you to add calculated fields to the database.    Calculated fields use dBase 

expressions to build new fields from combinations of existing fields.

· Delete
- Deletes the field selected in the fields window.

· Filter ...
- Allows you to set or remove a filter on the data which will be contained in the selected 

field.    By setting a filter on a particular field you can limit the records displayed in the 
database to the range of records that correspond to the filter limits you have chosen.

· Expression ...
- Allows you to specify dbase compatible filter expressions for the selected field.

Display section

The display section of the Fields Tab allows you to set the display properties for each individual field in the
record.    The information displayed in this section refers to the attributes of the currently selected field in 
fields list box.    Some of the attributes for pre-defined fields cannot be changed.

The areas of the display section are as follows:

· Desc.
- Name of field.    This name appears in the column header of the phone list.

· Format As
- Several formatting options are available.    The formatting options are used to specify 

how the data contained in the field is to be displayed in the phonelist window.    The 



available options are:

No Formatting - Formatting is off.    Data appears as entered.
Upper Case - Force all text to upper case.
Lower Case - Force all text to lower case.
Capitalize First Letter - Capitalize the first letter of each word.
Phone Number - Format the text as a phone number.
Number - Format the text as a normal number.
Currency - Format the text as currency.
Date - Format the text as a date.
Logical (Yes/No) - Formats text as Yes or No.
Logical (True/False) - Formats text as True or False.
Logical (On/Off) - Formats text as On or Off.

· Width
-The width defines the actual width of the header column in pixels.    You may also 

change the width dynamically by using the mouse to click and drag the header in the 
phone list window.

· Display in List checkbox
-Checking this allows the current field to be displayed in the phone list.    Fields may exist 

in the phone list database that you do not wish to display in the phone list window.    
You can suppress the display of any field by un-checking this option.



Phone List Properties: Options Tab

The information on this tab is used change the phone list database.

NOTE:    Before making any changes, make sure the phonelist you want to change is selected in the 
Phone Lists window.

Areas on this tab are described below:

· Description
- Allows you to change the description (name) of the selected phonelist.    This is the text 

that appears in the Tab associated with the phonelist.

· Show in Tab Bar checkbox
- Check this if you want the phone list to appear as a tab in the dockable phone bar.    If 

this is not checked, the phone list will never appear as an available tab.

· Show Button Bar checkbox
-If checked, causes the Button Bar to appear in the phone list tab.

· Columns
-You can choose the buttons displayed in the Button Bar to be in 1 or 2 columns.

· Header Font ...      (DAVE: Possible Jump to this item?)
- Allows you to change the font used to display text in the phone list column header.

· List Font ...      (DAVE: Possible Jump to this item?)
- Allows you to change the font used to display the records of the phone list.



New Phone List

This dialog allows you to select the type of new database you would like to create.

COMponents provides four types of phone lists:

Local Phone List Database
Shared Phone List Database
View of Shared Phone List
View of Selected Phone List



Phone List Description

You enter a description for the phone list database in this edit field.

Descriptions of each phone list database will appear:

- in the Phone Lists window in the Phone List Properties dialog box.

- as text in the tabs on the phone list window.    (DAVE: Another name for phon lst win?)



Shared Phone Lists

This box presents the names of all the shared phone lists that have been created in the directory 
previously chosen in the select directory box.

Shared phone lists are phone lists that can reside on a network drive and can be shared with other users.

COMponents supports record-level locking on shared phone lists.    This option allows you to create a 
brand new globally shared phone list database.

If you merely want to gain access to an existing shared phone list you should select the View of Shared 
Phone List option instead.

To choose a phone list:

- Select it from the list and click on the [OK] button.

· To select another directory containing shared phone lists, use the [Browse ...] button.

· The [Info ...] button shows information on all files related to the selected phone list database.



Shared Phone List Information

This box shows information on all the files that make up the selected phone list database.

· Select the [Change Desc.] button to change the selected database.



Field Filter

You can set a filter on any record field in the phone list database.

· Use the [Remove Filter] button to clear an existing filter for the record field.



Add Calculated Field

You can add a new field to the list of record fields by creating calculated fields.

NOTE: COMponents does not support the creation of new fields, only calculated fields.

Calculated fields are combinations of pre-existing fields.    By applying special dBase functions and 
operators, you can create new fields for display in the phone list window.    For example, you might want 
to combine the Title and Name fields with the expression, TITLE + NAME to create a new field which 
would appear in the phone list as:    Mr. John Jones.

To create a new calculated field, do the following:

1. Create the new calculated field by combining existing fields and dBase expressions in the 
Expression box.    You may simply double-click on the Fields, Functions, and Operators lists in 
order to build the desired expression.

2. Click [OK] to return to the Fields tab.

3. Type a description for the newly created field.    This will show up in the Fields listbox and will 
be the new field name for the database record.



Add Phonelist Entry - Personal Tab

This tab allows you to enter basic information the new phone list record.

Not all of the fields must be completed, however, the Name: field is required and it is important to specify 
the country of the record being added and the proper phone numbers.    This information is used to 
determine phone numbers to dial when making outbound calls.

Note:    COMponents uses the information stored in Location Setup and the Coutry code for the phone 
record as well as the area code and phone number to determine how to dial any phone number.    If you 
would like to override this process and specify the number exactly as you type it in, simply prefix the 
number with an “=“ sign.    This will cause COMponents to dial the number exactly as entered.



Add Phonelist Entry - Special Tab

This tab allows you to enter additional information for a phone list record.

In addition to several other useful fields, the Keyword fields have special importance.    These fields can 
be used for any purpose you want    They are special, however, because you can do a Keyword Search 
on the entries in these fields.    You may want to use these fields to identiify certain groups in the phone 
lists and then perform a keyword search on them to get a list of just the records you would like to work 
with.

Modify entries in the Redial Options group to specify how and when a number should be redialed if the 
number is busy, or if there is no answer, etc.    The entries specified in this tab apply be default whether 
you are dialing a datacom number, fax number, pager number, or telephony number.



PhoneList Records

This page allows you to add, delete, and modify phone list records.

- Select a phone list you want to edit by clicking on the phone list’s tab then use the buttons 
below the records list to perform the desired operation(s):

Add... - Use to add a new record to the selected phone list.
Edit... - Use to modify the record selected in the records list.
Delete - Deletes record selected in the records list.
Notes... - Edit notes for the record selected in the records list.
Add to Group... - Adds the selected record to a group.
Duplicate - Duplicates the selected record.
Add Group - Add a new group to the phone list.
Delete Group - Deletes the selected group.
Find... - Invokes the find dialog.
Print... - Invokes the print phonelist dialog.
Import... - Invokes the import phonelist dialog.
Export... - Invokes the export phonelist dialog.
Keyword... - Invokes the keyword search dialog.



Notes

Notes are used to jot-down information about records in a phonelist.

Each record in the phone list can have an unlimited number of notes associated with it.

To add notes to a record:

- Click on the [Add...] button.

NOTE:    If you delete a record from the phone list, the notes associated with that record are also 
deleted.

The upper list box of this dialog allows you to sort the notes by date or description.    The edit field below 
contains the text of the currently selected note.    Once a note has been added its description and notes 
text can be modified at any time.

Hint:    You can quickly access the notes from the phone tab bar by right-clicking on the record you wish to
see notes on and selecting Notes... from the pop-up menu.



Add Note

Enter a description for the new note being added.

The description does not need to be unique and can be changed later if desired.



Add to Group

The selected record will be added to all the groups that you specify in the groups listbox.

This allows you to add a single record to more than one group at a time if you wish.

The scope radio button allows you to determine whether only the currently selected record is added to the
selected groups or whether all phone list records are added to the selected groups.

After adding records to a group, the records appear in that groups folder in the phone list window.



Create Group

Creates a new group.

The COMponents phone list engine supports an unlimited number of groups per phone list.

Specify the name of the group in this dialog and the newly created group will appear in the groups section
of the phone list window.

Groups are useful for dialing multiple locations without having to search the database for the entries.



Find Personal

Search for information using search values based upon phone list record fields.

This tab is identical to the tab displayed when adding or editing phone list records.

You may enter a value to search for in any field and its match(es) will be looked up in the records of the 
database.    For example, if    CA is entered for the state, a search of the entire database for all records 
matching CA in the State field will be done.    Once the database has been searched, a list of all the 
records that matched the search criteria will be displayed.



Find Special

Search for information using any search value.

This tab is identical to the tab displayed when adding or editing phone list records.

You may specify entries in any field that you wish to look for match on in the records of the database.    
For example, if you specify a specific Keyword, a search of the entire database for all records matching 
that Keyword text will commence.    Once the database has been searched you are presented with a list of
all the records that matched the search criteria.



Keyword Search
Perform a narrow search of the phone list for all records that match whatever Keyword text you specify.

For example, if you had several records in the phone list that contained the text “East Coast” in the 
Keyword 1 field, you could search for all of them by typing “East Cost” in the Keyword 1 field and clicking 
OK.    Once all records have been searched you will be presented with a list a matching entries.



Logical Field Filter
Select the field filter for Logical values.    You may filter by TRUE values or FALSE values or ingnore the 
values altogether.



Log/Mailbox Access
This dialog works in a manner very similar to the PhoneBook Access dialog.    On the left pane of the 
dialog you can select which mailbox you wish to view entries for by clicking on the folder representing the 
mailbox you wish to access.    Furthermore, by double-clicking the LEFT mouse button on a mailbox folder
you can expand or un-expand the structure beneath it.    When a mailbox folder has been expanded you 
will see an InBox, an OutBox, and an Archive folder.

The list box of log entries in the right pane will show only those entires that match the selected folders in 
the left pane.    You may sort the entries in this list by clicking the LEFT mouse button on the column 
header corresponding to the information you wish to sort the list on.    By default the list is sorted by 
Date/Time.

If you select the main MailBox folder, all entries (InBox, OutBox and Archive) will be displayed in the list.    
If you expand the MailBox folder you can easily “filter” the entries you wish to view in the right pane by 
highlighting only those portions of the MailBox tree that you wish to view.    For example, if you wish to 
view only InBox and OutBox entries for fax, you must fully expand the InBox and OutBox folders so that 
the FAX icon is visible for both folders.    Highlight the FAX icon under InBox by clicking the LEFT mouse 
button on it.    Only InBox FAX entries will be displayed in the list on the right.    If you also which to view 
OutBox FAX entries at the same time, CTRL-LEFT click the mouse on the FAX icon under OutBox.    You 
will see that both entries are now selected and the list on the right will display all entries combined for 
both the InBox and OutBox.    You may make selections this way in any combination you wish.    By 
selected the “root” MailBox ALL possible log entries will be display together in the right pane.

The upper right of the dialog contains a line of text describing how many Un-read items there are in your 
InBox.    You can use this to quickly see if any new faxes have arrived since you last checked.
There is also a checkbox which if checked, limits the right pane to display only those InBox items that are 
marked as Un-read.

TIP:
If you encounter a situation where it appears that no matter which folders you select on the left, 
no items are displayed in the list box on the right.    Check to make sure that you don’t have the 
“Show InBox Un-read Only” checkbox checked!

You can view items in only the InBox by clicking the LEFT mouse button on the InBox folder causing it to 
become selected.

Details... Displays a dialog of detailed information.
Re-Send... Invokes the Fax Wizard allowing you to easily re-send the fax files 

associated with the log entry.
Play New... Plays/Views all of the new (unread) messages.
Play/View... Displays the associated fax file in a VIEWCOMponent Window or plays 

the VoiceMail message.
Forward Copies an entire log entry from one mailbox to another.
Archive Moves log entries from the InBox or Outbox to the Archive folder.
Un-Archive Moves log entries from the Archive folder to the Inbox or Outbox.
Print... Prints the associated fax file
Error Help... Invokes the help system with a description of the associated logged error

code.
Delete Deletes the currently selected log entry.    To delete the entire log at once,

click the RIGHT mouse button on the surface of the log entry window and
pick the Clear Log... option.

TIP:
You may click the RIGHT mouse button at any time on the surface of the log entry window to 
display a popup menu of the most commonly used log functions.





Forward Log Entry
Use this dialog to select one or more mailboxes that you would like to forward the selected 
log entries into.    The log entries will be copied into each selected mailbox.



Clear Log Dialog

You may clear the entire log at once, or just a single entry.    Select the desired operation and click OK.

Note:    Clearing the entry from the log is a permanent action.    Other files associated with the log entry 
may also be deleted.



Print PhoneList

Print Phone List allows you to print the contents of the phone list to your printer.    Various attributes of the 
printed output can be set.

Format:

1 Record Per Line

Prints the phone list so that all of the fields in a single phone list entry are on one line.    This will conserve 
the most space, however, all fields may not fit on a single line.    The sort, field width, field position and 
field visibility are controlled by the phone list window.    If the field is made wider in the phone list window, 
it will occupy more room on the printed output.    If the field is not visible in the phone list window, it will not
be printed.

1 Field Per Line

Prints the phone list so that each field of a phone list entry is printed on a separate line.    This    occupies 
the most space, however, it will ensure that all fields are printed.    As with printing 1 record per line, the 
field attributes are controlled by the phone list window.

Print Field Names:

If this options is checked, the field names will be printed at the top of each page if 1 Record Per Line is 
selected or to the left of each field if 1 Field Per Line is selected.



Import Options

When importing from a comma-delimited text file, there are various attributes of the input file that must be 
set.

First Line Includes Field Names

Select this option if the first line of the text file contains the names of the fields that are to be imported.    
This will allow you to map the fields by name rather than by position.

Field Separator/Quote Character

Specified the characters that delimit a field of text.    The most common field separator used is the comma.

Record Separator

Specified the character(s) that signify the end of a record.    The record can either be terminated by a 
carriage return/line feed pair or a form feed character.



Import Field Map

The Import Field Map allows you to specify which fields of the input file will be assigned to the fields of the
phone list.    Each field of the phone list is accompanied by a list of the fields that are available from the 
input file.    All of the fields of the phone list do not have to be assigned.    You only need to assign the 
fields that you wish to import.    Also, the same field from the input file may be assigned to more than one 
field of the phone list.    They do not have to be unique.



Export PhoneList

Export Phone List allows you to export the contents of the phone list to a comma-delimited text file.

The available fields are place into the exported fields list by double-clicking on the available field or by 
selecting the assign button.    The fields will be exported in the order that they appear in the exported 
fields list.    You may select as many fields to export as you wish, however, there must be at least one 
fields selected.



Tools Menu
This is a customizable menu which allows you to add your own tools and show or hide toolbars
in FAXCOMponent.

When you add tools to the menu, they will appear as menu commands below the Toolbars and Customize
commands.

Toolbars ... - Show or hide FAXCOMponent toolbars.
Customize ... - Add or remove commands to the Tools menu.



Toolbars

This dialog allows you to turn COMponent toolbars on or off.

With this function, you can arrange toolbars anywhere on the COMponent display.

The Toolbars listbox shows all of the available tool bars.    To change the tool bar status:

1) Select the toolbar you want from the list.
2) Click on [SHOW] to make the toolbar visible or [HIDE] to remove the toolbar from the
display.

If you turn on Tool Tips, a brief description of each tool is shown when you leave the mouse cursor over 
its icon for one second.



Customize

In Tools Menu Customization, you add new commands to the Tools menu.

A tool is a program or command external to COMponents, which you may want to use while in 
COMponents.    You may customize the Tools menu using this dialog to add any programs you like.

The customize dialog includes the following areas:

Menu Items:

Listbox - Contains a list of your added tools.

New - Add a new tool.
Remove - Delete the selected tool.
Move Up - Moves the list up.
Move Down - Moves the list down.

Tabs:

General - Basic information for the added tool. 
Window - Defines the size and position, etc. for the tool window. 
Console - Defines a color scheme for the tool window. 
Options - Other items that define the behavior of the tool. 



Cascade

Cascade all open windows from the upper left corner of the work space.



Tile Horizontally

Tile all windows horizontally.



Tile Vertically

Tile all open windows vertically.



Arrange Icons

Line up all iconic windows.



Split Window

Splits the active window into two panes.



Index

Display the COMponent help contents page.



Using Help

Display information on using the Microsoft Windows Help System.



FAX Error Codes

100 -- Modem initialization failed.
101 -- Modem not turned on.
102 -- Modem not a Fax/Modem.
103 -- Fax file conversion failed.
104 -- No pages in fax document.
105 -- Unable to configure COM port.
106 -- No remote answer.
107 -- No local dialtone.
108 -- No carrier.
109 -- Remote line busy.
110 -- Send fax handshake failure.
111 -- File open failure.
112 -- No fax connection.
113 -- No End Of Page response from remote fax.
114 -- No End Of Stream response from remote fax.
115 -- Create file failure.
116 -- Out of disk space.
117 -- Receive fax parameters negotiation failure.
118 -- Receive fax handshake failure.
119 -- No receive fax connection.
120 -- No End Of Stream received.
121 -- No End Of Page response.
122 -- Disconnect failure.
148 --User cancelled operation.



Error 100: Modem Initialization Failed
Problem:

Your modem could not be intialized properly for faxing.

Solution:
Check to make sure you modem is turned on if it is an external model.    Also check to make sure 
that the line and COM port associated with the modem are accurate.    Finally, check the Fax Tab 
in the line/modem configuration dialog (accessable from the Options menu) to ensure that the fax 
Class setting matches that of your modem.

See Also:    Line/Modem Setup:    Fax Tab



Error 101: Modem Not Turned On
Problem:

Your modem could not be intialized properly for faxing, it may be turned off

Solution:
Check to make sure you modem is turned on if it is an external model.    Also check to make sure 
that the line and COM port associated with the modem are accurate.    Finally, check the Fax Tab 
in the line/modem configuration dialog (accessable from the Options menu) to ensure that the fax 
Class setting matches that of your modem.

See Also:    Line/Modem Setup:    Fax Tab



Error 102: Modem Not a Fax/Modem
Problem:

Your modem could not be intialized properly for faxing, it may be turned off.

Solution:
Is your modem a fax modem?    If it is, check the Fax Tab in the line/modem configuration dialog 
(accessable from the Options menu) to ensure that the fax Class setting matches that of your 
modem.    Check to make sure you modem is turned on if it is an external model.    Also check to 
make sure that the line and COM port associated with the modem are accurate.

See Also:    Line/Modem Setup:    Fax Tab



Error 103: Fax File Conversion Failed
Problem:

The FAXCOMponent failed to properly convert fax files and/or cover pages and headers.

Solution:
Check to make sure you have enough disk space on the hard drive where COMponents is 
installed.    All files sent as faxes must be one of the supported graphic formats.    Also check to 
make sure that the selected Cover Page and Header files if any actually exist on your system.    
You can check by trying to open them from the Cover/Header Gallery from the File menu.    There 
is a remote chance that you system may have run out of memory or system resources.    Try 
closing down other open applications and try the fax send again.



Error 104: No Pages In Fax Document
Problem:

The selected fax document has no pages.

Solution:
Recreate the document.



Error 105: Unable To Configure Port
Problem:

The COM port could not be properly configured to send the fax.

Solution:
Try sending the fax again.    If the error continues to occur you may have a hardware problem with
your serial port or internal modem.



Error 106: No Remote Answer
Problem:

The remote fax never answered the phone.

Solution:
Choose [Re-Send...] from the Fax Log to retry sending the fax.    You may adjust the number of 
times the FAXCOMponent will attempt to redial a fax number when it does not answer.

See Also:    Advanced Fax Options



Error 107: No Local Dialtone
Problem:

Your modem did not detect a dialtone prior to dialing.

Solution:
Make sure that your phone line is plugged into the proper jack on the back of your modem.    
Usually there are two RJ-11 phone jacks:    TELCO which is used to connect another phone 
through your modem and LINE which is where the phone line should be plugged in.

See Also:    Advanced Fax Options



Error 108: No Carrier
Problem:

After dialing, the remote fax answered but the two modems were unable to establish a 
communications link.

Solution:
Unusually high levels of “noise” on the phone line can often cause this to occur.    Try sending the 
fax again.    If the problem persists, there may be a problem with you phone service.

See Also:    Advanced Fax Options



Error 109: Remote Line Busy
Problem:

The remote fax was busy each time connecting was attempted.

Solution:
Re-send the fax when the line is not busy.    You may also increase the number of retries when a 
line busy through the Fax Advanced Options dialog in the phone list record.

See Also:    Advanced Fax Options



Error 110: Send Fax Handshake Failure
Problem:

A communications link was successfully established with the remote fax, however, the two faxes 
were unable to properly “talk” with each other.

Solution:
Try resending the fax.    If the problem persists, there may be an incompatibility between the two 
faxes.    Try sending the fax to another fax machine to see if it makes a difference.    If the second 
machine is able to successfully receive the fax, there is a hardware incompatiblity between the 
two faxes.



Error 111: File Open Failure
Problem:

A file failed to open successfully during the faxing process.

Solution:
Try resending the fax.    If the problem persists, check to make sure the files you are sending are 
valid fax files and that your hard drive has enough free disk space.



Error 112: No Fax Connection
Problem:

A communications link was successfully established with the remote fax, however, the two faxes 
were unable to properly “talk” with each other.

Solution:
Try resending the fax. If necessary, try lowering the maximum fax baud rate in the phone record 
you are sending to before resending.    If the problem persists, there may be an incompatibility 
between the two faxes.    Try sending the fax to another fax machine to see if it makes a 
difference.    If the second machine is able to successfully receive the fax, there is a hardware 
incompatiblity between the two faxes.

See Also: AddPhoneList Entry - Fax Tab



Error 113: No End Of Page Response From Remote Fax
Problem:

The two faxes were unable to properly negotiate during End Of Page processing.    Some pages 
may not have been successfully sent or received.

Solution:
Although the FAXCOMponent has been optimized to send faxes in the background, excessive 
hard drive activity during the faxing process can cause this error to occur.    Try resending the fax 
while no other applications are running.

If the problem persists, there may be an incompatibility between the two faxes.    Try sending the 
fax to another fax machine to see if it makes a difference.    If the second machine is able to 
successfully receive the fax, there is a hardware incompatiblity between the two faxes.



Error 114: No End Of Stream Response From Remote Fax
Problem:

The two faxes were unable to properly negotiate during End Of Stream processing.    Some pages
may not have been successfully sent or received.

Solution:
Although the FAXCOMponent has been optimized to send faxes in the background, excessive 
hard drive activity during the faxing process can cause this error to occur.    Try resending the fax 
while no other applications are running.

If the problem persists, there may be an incompatibility between the two faxes.    Try sending the 
fax to another fax machine to see if it makes a difference.    If the second machine is able to 
successfully receive the fax, there is a hardware incompatiblity between the two faxes.



Error 115:    Create File Failure
Problem:

The system failed to create a required file during the fax receive process.

Solution:
Make sure the drive on which COMponents is installed has plenty of free disk space.    Also make 
sure that your currently selected MailBox and InBox path are valid.

See Also:    FAXCOMponent Settings - Receive Tab



Error 116: Out Of Disk Space
Problem:

Your system ran out of disk space on the drive where COMponents is installed.

Solution:
Make sure the drive on which COMponents is installed has plenty of free disk space.    Also make 
sure that your currently selected MailBox and InBox path are valid.

See Also:    FAXCOMponent Settings - Receive Tab



Error 117: Receive Fax Parameters Negotiation Failure
Problem:

The two faxes were unable to properly negotiate baud rate or other parameters.

Solution:
Try resending the fax.    If necessary, try lowering the maximum fax baud rate in the phone record 
you are sending to before resending.    If the problem persists, there may be an incompatibility 
between the two faxes.    Try sending the fax to another fax machine to see if it makes a 
difference.    If the second machine is able to successfully receive the fax, there is a hardware 
incompatiblity between the two faxes.

See Also: AddPhoneList Entry - Fax Tab



Error 118: Receive Fax Handshake Failure
Problem:

The two faxes were unable to properly negotiate baud rate or other parameters.

Solution:
Try resending the fax.    If necessary, try lowering the maximum fax baud rate in the phone record 
you are sending to before resending.    If the problem persists, there may be an incompatibility 
between the two faxes.    Try sending the fax to another fax machine to see if it makes a 
difference.    If the second machine is able to successfully receive the fax, there is a hardware 
incompatiblity between the two faxes.

See Also: AddPhoneList Entry - Fax Tab



Error 119: No Receive Fax Connection
Problem:

A communications link was successfully established with the remote fax, however, the two faxes 
were unable to properly “talk” with each other.

Solution:
Try resending the fax. If necessary, try lowering the maximum fax baud rate in the phone record 
you are sending to before resending.    If the problem persists, there may be an incompatibility 
between the two faxes.    Try sending the fax to another fax machine to see if it makes a 
difference.    If the second machine is able to successfully receive the fax, there is a hardware 
incompatiblity between the two faxes.



Error 120: No End Of Stream Received
Problem:

The two faxes were unable to properly negotiate during End Of Stream processing.    Some pages
may not have been successfully sent or received.

Solution:
Although the FAXCOMponent has been optimized to receive faxes in the background, excessive 
hard drive activity during the faxing process can cause this error to occur.    Try re-receiving the 
fax while no other applications are running.

If the problem persists, there may be an incompatibility between the two faxes.    Try receiving the 
fax from another fax machine to see if it makes a difference.    If the second machine is able to 
successfully send the fax, there is a hardware incompatiblity between the two faxes.



Error 121: No End Of Page Response
Problem:

The two faxes were unable to properly negotiate during End Of Page processing.    Some pages 
may not have been successfully sent or received.

Solution:
Although the FAXCOMponent has been optimized to receive faxes in the background, excessive 
hard drive activity during the faxing process can cause this error to occur.    Try re-receiving the 
fax while no other applications are running.

If the problem persists, there may be an incompatibility between the two faxes.    Try receiving the 
fax from another fax machine to see if it makes a difference.    If the second machine is able to 
successfully send the fax, there is a hardware incompatiblity between the two faxes.



Error 122:    Disconnect Failure
Problem:

The two faxes were unable to properly terminate the fax transfer.    Most likely, all pages will have 
been successfully sent or received.

Solution:
Try re-receiving the fax while no other applications are running.

If the problem persists, there may be an incompatibility between the two faxes.    Try receiving the 
fax from another fax machine to see if it makes a difference.    If the second machine is able to 
successfully send the fax, there is a hardware incompatiblity between the two faxes.



Error 148: User Cancelled Operation
The fax transfer was abruptly terminated on the local modem when the user clicked the Abort 
button in the status window or selected Abort Transfer from the Fax Menu.



Add Phonelist Entry - Fax Tab

This tab contains all of the specific information you can define for the record, related to faxing.

The areas on this tab are:

· Dial Options

- Allows you to modify the manner in which the fax number is dialed.
See Dial Options for more infomation.

· Cover Sheet/Header Options

- This section allows you to define default cover sheet and header for fax sending.    By 
selecting from the list of availble cover sheets and headers you can pre-specify the 
cover sheet or header that will be used when you send to a particular record.    This can
help to speed up the process of scheduling a fax job.

NOTE: Only the list of covers and headers that have been added to the Coverpage and
fax header Galleries appear in this section.

· Send Options

- Use this section to specify details about how faxes should be sent for this record.

Queue Priority
- The priority can be selected allowing you to specify the relative importance of 

the jobs associated with a record.    Higher priority jobs will be sent from the 
queue before lower priority jobs.

Resolution
- The default resolution for files that need to be converted can be specified.

Baud Rate
- You can specify a Maximum and Minimum baud rate that will be used for faxing.

You may want to specify a maximum rate that is lower than the capabilities of 
your modem to account for poor line quality to a particular location.    A higher 
minimum baud rate can be used to for faxes to be send at a minimum speed.

· Advanced Options
- This allows you to specify some advanced fax options.
See Advanced Options for more information



Location Setup Dialog

On the left of the dialog there is a list box that contains the current locations that you have configured.    
Only one, however, can be set as the default location.    It is the default location that is used when 
COMponents is trying to figure out how to dial phone numbers.    By using the options that can be set from
this page, COMponents can automatically determine the sequence of digits to dial in order to make 
International, Long Distance, and Local telephone calls.

The “Default Location” is the list box entry that has the Blue diamond next to it.    To change the default 
location to another location configuration simply click the LEFT mouse button on the “empty” diamond 
next to the location you wish to make the currently active configuration.    You should see the diamond fill 
in with Blue to indicate that it is now the current location.

New
To create new location configurations, simple select the [New] button.    You will be prompted to 

enter a description for the new location.    Once the description is entered you can go through the rest of 
the tabs in the dialog inputting the specific settings for the new location.

Remove
Locations can be removed at any time by selecting the location you wish to remove from the list 

box and clicking the Remove button.    You may not remove the last location because there must be at 
least one valid location in order for COMponents to properly dial.

Location Settings Tabs
Location Configure basic phone system related settings.
Outside Access Configure settings for dialing out from PBX or company phone systems.
Address Setup details used when filling out cover pages.
Phone Numbers Setup details used when filling out cover pages.



Location Setup: Location Tab

This tab allows you to setup phone system values specific to the currently selected location

Country
Select the country that corresponds to the location you are setting up.    The country 
setting is used to determine whether a call is an international call.    Also when the country
is selected the Country Code for that country is automatically inserted into the proper edit 
field below.    You may change the Country Code setting manually if it is not accurate.

International Access Number
Enter the number that your local phone system requires you to dial for international calls.  
This number will be dialed by COMponents when it determines that the destination you 
are dialing is in a different country from the one specified above. 

Country Code
This number is phone system identifier that must be dialed when another country is 
calling into your current location.    This number is automatically input for you when you 
select your country from the list.    You may change it manually if necessary.

City/Area Code
This is the City or Area Code of your current location.    In the United States this is always 
a three digit number.    This is a very import setting because it is used to determine 
whether or not to dial the call as local or long distance.    You can enter more than one 
area code in this edit field if you need to dial locally to more than one area code.    Simply 
separate each area code by a semi-colon. (;).

Long Distance Access Number
This number is the dialed prior to the actual phone number when COMponents has 
determined that the number being dialed is a long distance call.    A call is determined to 
be Long Distance when the City/Area code for the phone record you are dialing does 
NOT match the Area/Code you have set up for your current location in this dialog.    In the
United States, this number is usually 1.

Dial Suffix
If you need to dial trailing digits on every number dialed, set them up in this field.    The 
numbers are dialed exactly as entered after the phone number has been dialed.

Disable Call Waiting
Enter the sequence of digits required to disable call waiting.    On most phone systems in 
the United States, this number is *70.

Block/Unblock Caller ID
Enter the key sequence required to either block or unblock caller id depending on how 
you have your phone line configured through phone company.



Location Setup - Outside Access

Enter specific information used to access outside lines from with companies, or internal 
phone systems.

Long Distance Prefix
If you are required to dial a specific number to aquire a Long Distance outside line, enter 
that number here.    You may have to enter a number here if you are trying to dial out from
a PBX or company phone system.    If you are using a standard telephone connection, the
Long Distance Prefix is normally not required.

Local Prefix
If you are required to dial a specific number to aquire a Local outside line, enter that 
number here.    You may have to enter a number here if you are trying to dial out from a 
PBX or company phone system.    If you are using a standard telephone connection, the 
Long Distance Prefix is normally not required.



Location Setup: Address Tab

Enter all the appropriate information for the currently selection location on this tab.    This information is 
used to “fill” any user-defined fields you may have on your Cover Pages or Headers when sending a fax.   
None of this information is required for proper outbound dialing.



Location Setup: Phone Numbers Tab

Enter all the appropriate information for the currently selection location on this tab.    This information is 
used to “fill” any user-defined fields you may have on your Cover Pages or Headers when sending a fax.   
None of this information is required for proper outbound dialing.



New Location Name

Enter a name for the new location.    The name does not have to be unique, however, it is suggested that 
it be made unique so that you can distinguish easily between your location configurations.



Workspace Tab

This tab allows you to change settings that affect how the Workspace itself looks and operates.

User Level
Note:    Changing the user level will have no effect until you restart the application.

Novice
Novice mode limits the number of options available to you when running the COMponent. 
The major limitations are that you will not be able to run/open multiple lines/modems at 
the same time and some toolbars and menu options are not available.    Each 
COMponent has different limitations.    This mode provides the beginning user with an 
easier interface.

Advanced
Advanced mode gives you access to all of the features available in each COMponent 
Module.    Including the ability to run multiple sessions/modems simultaneously.

Autosave Workspace Layout
When enabled, automatically saves the size and position of all open windows when the 
COMponent is closing down so that the next time the COMponent is run the previous state is 
restored.

Display Status Bar
When enabled, the status bar is displayed at the bottom of the COMponents window.

Background Color
Use these options to change the color of the COMponent windows’ background.

Background Bitmap
You may also display a bitmap on the background of the COMponent window.



Language Selection

This dialog allows you to change the language used in the user interface.    The Select New Language 
combo box contains a list of the installed COMponent language modules that you have available.    Simply
select the language you wish to see the user-interface in and click OK.    The Language will be 
automatically changed.



Color
This tab may or may not appear depending upon which COMponent module is active.    You use this tab 
to setup colors for the various screen elements used in the status displays.



Line/Modem Setup

A list of the currently installed lines is displayed.    Select the line you wish to perfom an action on by 
clicking the LEFT mouse button on the line.    The operations you can perform on lines are the following:

Add... Adds a new line/modem.
Remove Removes an existing line/modem
Configure... Edits an existing line/modem configuration.



Detect Modems

Once you have your modem hardware properly installed, COMponents will attempt to automatically find 
and identify your modem when you choose to add it through Line/Modem Setup.    A modem MUST be 
added through Line/Modem Setup in order for COMponents to recognize your modem!

The dialog is split up into the following sections:

Detection Mode
Selecting auto-detect port will force the software to look for your modem on all COM ports.    If you
know which COM port your modem is installed on chose “Select COM Port” and use the combo 
box to specify the port your modem is configured on. 

Don’t Auto-detect Modem;    I will select it from a list
Turn this option on if you do not want the software to attempt to identify the exact model of your 
modem.    Turning this option off will speed up the process of installing your modem, however, we 
recommend that you let the software attempt to identify your modem automatically. 

Detection Progress
This section is informational only.    It keeps you informed of the current detection progress.

Once you have made the appropriate choices, choose [Detect...] to cause the software to begin the auto-
detection process.    Once the detection is complete you will be prompted on how to proceed depending 
upon the results of the automatic detection.



Configure Line/Modem

This tabbed dialog allows you to change all of the settings for a specific line/modem.

The available Tabs are the following:

General Tab Configure general line settings.
AddressTab Configure line specific address options.
Fax Tab Configure fax specific line settings.
Dial Tab Configure dialing options.
Speaker Tab Configure speaker options.
Protocol Tab Configure Datacom connection settings.
Initialization Tab Configure modem initialization string options.



Configure Line/Modem: General Tab

Use this tab to specify the COM port to which your modem is attached.    You may also change the Line 
Name.    The Line Name is the name which is presented in the Line Selection dialog.



Configure Line/Modem: Address Tab

This tab allows you to specify the phone number of the line to which your modem is attached.    You may 
also specify the type of calls that the modem will be receiving, and the number of rings that should occur 
before the modem answers incoming calls.



Configure Line/Modem: Fax Tab

This tab allows you to specify settings specific to FAX if you have a fax modem installed.

The dialog is split up into the following sections:

Settings
Select the options you want enabled for your fax modem.    We recommend that you DO NOT turn
on Software Flow Control unless you are having problems sending faxes and you have an older 
fax/modem.

Protocols
Select which type of protocol you wish to use for faxing.    All protocols may not be available on 
your modem.    In general, Class 2.0 is more robust than Class 2, and Class 2 is more robust than
Class 1.

Error Management
Select the appropriate options.

Fax Station Identification
Enter up to 19 characters to identify your fax/modem to others.



Configure Line/Modem: Dial Tab
Use this tab to configure settings related to dialing.



Configure Line/Modem: Speaker Tab
Use this tab to configure settings related to the modem’s speaker.



Configure Line/Modem: Protocol Tab
Use this tab to configure settings related to data communications.



Configure Line/Modem: Initialization Tab
Use this tab to add any additional modem initialization options.    Any additional initialization string you add
will be sent out after all other modem initializations.    This feature allows you to completely override any of
the configuration based initialization strings.



Modem Identified

A new modem has been identified from the program’s autodetection dialog.    Check the model of the 
modem that the software has identified to ensure that it matches your actual modem.    There are several 
options available:

Add
If the software has properly identified your modem choose this option to actually add it as a new 
line.

Select
If the software has not properly identified your modem choose this option to manually select you 
modem’s model.    If your manufacturer or model does not appear in the list, choose Unlisted 
Manufacturer and select the appropriate generic modem type.

Skip
If you have more than one modem installed and the identified modem is not the one you wish to 
add, select skip.    If you chose to auto-detect ports in the Modem Detection dialog then the 
software will continue to test the rest of the ports on your system looking for another modem.    
Otherwise, the detection process is complete.

Cancel
Doesn’t add the modem as a new line and aborts the detection process.



Modem Unidentified

A new modem has been identified from the program’s autodetection dialog.    However, it was not able to 
detect the exact model of modem that you have.    There are several options available:

Select
Takes you to another dialog which allows you to select the manufacturer and model of your exact 
modem.    If your manufacturer or model does not appear in the list, choose “Unlisted 
Manufacturer” and select the appropriate generic modem type.

Skip
If you have more than one modem installed and the identified modem is not the one you wish to 
add, select [Skip].    If you chose to auto-detect ports in the Modem Detection dialog then the 
software will continue to test the rest of the ports on your system looking for another modem.    
Otherwise, the detection process is complete.

Cancel
Doesn’t add the modem as a new line and aborts the detection process.



Modem Selection

The upper list box contains a list of all available modem manufacturers.    Select the manufacturer that 
corresponds to the modem you are trying to install.    If your modem’s manufacturer is not listed and you 
have a disk with modem configuration files (supplied by V3, Inc.), choose [Have Disk...] and specify the 
path to the configuration files.

The lower list box contains a list of modem models provided by the selected manufacturer.    Select the 
model that matches the modem you are installing and pick the [Select] button to add it.    If your modem 
does not appear in the list, select the closest match.



Line Setup

From the list of installed lines, select the line that you would like this new COMponent Window to use.

Note:    You may have only one COMponent Window of each type open on any one line at any one time.    
This means that you may have the DATACOMponent and FAXCOMponent sharing a single line, but you 
cannot have two FAXCOMponent Windows on the same line.

See Also:    Line/Modem Setup



o.tel.o Multi-Fax Service Setup

This tabbed dialog allows you to change all of the settings for a o.tel.o Multi-Fax Service Setup.

The available Tabs are the following:

Service Tab Configure general service settings.
Phone Tab Configure specific phone options.
Line Tab Configure specific line settings.
Schedule Tab Configure schedule options.



o.tel.o Multi-Fax Service Setup: Service Tab
Use this tab to configure Service settings related to the currently selected Service.

Description
The name of the Service location.

Settings for
Fax Submission, submits messages and Fax Status, retrieves message status.

User ID
The User ID for the Gateway.

Password
Four-character password for the User ID.

Mnemonic
The name of the sides Ex: megap for the Fax Submission and megman for the Fax Status side. 
Mnemonics are related to different nodes and the affiliate X.25 PAD device.



o.tel.o Multi-Fax Service Setup: Phone Tab
Use this tab to configure Phone settings related to the currently selected Service.

Settings for
Fax Submission, submits messages and Fax Status, retrieves message status.

Area Code
The area code for the phone number.

Phone
The phone number for o.tel.o Multi-Fax Service access.

Country
The country where the service resides. It automatically calls the related cities on the left window. 
The default for the country will come up in the country that is set for the current location in 
Location Setup.

Redial Options
Setting for different actions based on the call result.

Call Result
Dropdown with following options: Busy; No Carrier; No Answer; No Dialtone.

Retries
Number of Retries.

Delay
Delay between retries.



o.tel.o Multi-Fax Service Setup: Line Tab
Use this tab to configure Line settings related to the currently selected Service.

Settings For
Fax Submission, submits messages and Fax Status, retrieves message status.

Baud Rate
From 110 to 130400 baud/sec. In order to achieve a 28,800 connection the baud rate should be 
set at 57,600 or higher allowing for data compression. All baud rates listed are valid rates that you
may select.



o.tel.o Multi-Fax Service Setup: Schedule Tab
Use this tab to configure Schedule settings related to the currently selected Service.

Automatic Status Retrieval
When this box is checked the retrieval times are set in the Retrieval Time fields. When it is not 
checked the manual retrieval is activated.

For Status Retrieval Schedule we can manipulate the retrieval time with the Day and Time field in 
the From and To Columns.

From: To:

Day: Monday Friday

Time: 07.00 18.00

The client will then check the status from 09.00 to 18.00 every day from Monday to Friday. The 
display of AM PM is determined by the regional settings in the operating system. If the settings 
are in 24-hour format, AM PM will not show up.

Retrieval Frequency
Indicates the time between each call to o.tel.o Multi-Fax Service for checking of the status. Enter 
a time in minutes (default is 5 minutes). It will only call as long as the status of some jobs are not 
complete.

If the submission fails, the entry will be moved to the log with an error recorded.



Dial Options

You can override the default dialing options for any records by changing the options in this dialog.    The 
number that will be dialed is displayed at the top of the dialog.

There are three different categories of options that may be modified:

International Options -- Checking this option causes the international access number (011 for the United
States) to be dialed if the number is an international call.    This option is checked on by default.

Long Distance Options -- Checking this option causes the long distance access number (normally 1 for 
the United States) to be dialed if the number is a long distance call.    This option is checked on 
by default.

Local Options
Dial as Long Distance (Local Toll) -- Checking this option causes a local number to be dialed as 

though it were a long distance number. The Long Distance Options are observed when dialing 
as a local toll.    This option is checked off by default.

Omit First Digit of Phone Number -- Checking this option causes the first digit of the phone number 
to not be dialed.    In some countries when dialing a local call, the first digit is not required.    This 
option is checked off by default.



Service Dialing

International Access
Enter the number required for the service to dial out to international fax recipients.

Long Distance Access
Enter the number required for the service to dial out to long distance fax recipients.




